
Virtual Geologic Mapping Exercise at McCauley, WV 
 
This virtual mapping exercise focuses on a 7 square kilometer field area just east of the 
town of Baker in northeastern West Virginia (Figure 1; approximate latitude: 39.05˚, 
longitude: -78.72˚). The basic geology consists of a layered sequence of Silurian to 
Devonian clastic and carbonate rocks that are complexly folded. Virtual field 
investigations and construction of a geologic map will be facilitated by using the Google 
Earth virtual globe. The exercise works best with the web version of Google Earth, which 
can be accessed using the Chrome, Firefox, Opera, or Edge browsers at the URL below: 
 

https://earth.google.com/web/ 
 
Note that the web version of Google Earth does not work with Safari or Internet Explorer. 
The exercise will work on the desktop version of Google Earth, but some of the GE tools 
are located in alternate places and work slightly differently.  
 

 
Figure 1: McCauley field area outlined by the yellow polygon and title with project information, as seen in 
web Google Earth 

 
The McCauley mapping exercise makes use of a KML file of field data, which can be 
downloaded from the URL below: 

https://educ.jmu.edu/~whitmesj/Fieldwork/McCauley/
McCauleyMappingProject.kml 

https://earth.google.com/web/
https://educ.jmu.edu/~whitmesj/Fieldwork/McCauley/McCauleyMappingProject.kml
https://educ.jmu.edu/~whitmesj/Fieldwork/McCauley/McCauleyMappingProject.kml


Exercise Goals:  
1. In Google Earth, virtually traverse the full field area, visiting outcrops (indicated 

by colored orientation symbols or dots) and collecting field data. 
2. Build a geologic map in Google Earth by drawing contacts between lithologic 

units. Draw polygons, colored by unit, to represent the interpreted regions for 
each lithologic unit. Fold axes and/or faults should be indicated. Upon 
completion, the full mapping area, as denoted by the large yellow polygon, 
should be colored. Neatness counts! 

3. Interpret the geology of the field area by writing detailed descriptions of the 
lithologic units, constructing a cross-section that interprets the geology of the 
area, and writing a memoir/summary of the geologic history of the field area. 

 
To investigate the field area, start by opening 
Google Earth in your web browser, using this web 
address: https://earth.google.com/web/. Once you 
are in Google Earth click on the “File” dropdown 
menu at the upper left side of the window, select 
“Import KML / KMZ file”, and import the 
“McCauleyMappingProject.kml” file from your 
computer (see Figure 2.) If you haven’t downloaded 
the file to your computer yet, it is available here: 
https://educ.jmu.edu/~whitmesj/Fieldwork/McCaul
ey/McCauleyMappingProject.kml.  
Once the KML file is loaded, your window should 
look similar to Figure 1. 
Now you can start investigating the field area; the 
boundaries of the field area are indicated by the 
yellow polygon. We suggest that you start at the 
location of the red Placemark, entitled “Start here” 
(northwest region of mapping area) and traverse 
down the road to the southeast. In Google Earth 
you can use the - and + icons (lower right in your 
window) or use your mouse wheel to zoom in and 
out. As you zoom closer to the ground surface, 
outcrop data will appear in the form of colored 
orientation symbols or dots. Click on these symbols 
for outcrop data and (sometimes) photos of the 
outcrop. 
You might find it helpful to use <SHIFT>arrow keys 
to tilt and rotate your field of view; clicking on the 
3D button in the bottom right will also tilt the view.  

You can also drag the white 
person icon (lower right of 
the window) to the roads for 
StreetView imagery of the 
landscape. 
 

 
Figure 2. Loading a KML file in 
Google Earth 

 

https://earth.google.com/web/
https://educ.jmu.edu/~whitmesj/Fieldwork/McCauley/McCauleyMappingProject.kml
https://educ.jmu.edu/~whitmesj/Fieldwork/McCauley/McCauleyMappingProject.kml


You will notice that the geologic field 
data only appears when you are 
zoomed close to the ground surface. A 
basic key for the mapping units in your 
field area can be viewed by clicking the 
"McCauley Units" label below the 
“McCauley Mapping Project” menu at 
the left (also see Figure 6). However, 
you will need to visit the virtual 
outcrops to get details on the features 
of the lithologic units in order to 
complete your lithologic descriptions 
(see Exercise Deliverable #2 below.)  

 
Figure 3. Examples of Placemark, black contact 
lines, and colored polygons for unit areas. 

To complete your geologic map of the field area you will need to add lines for contacts 
and faults (click on the "Add" dropdown menu and select "Polygon"). You can create 
colored regions to represent your interpretation of the areal extents of each unit by using 
the same tool to fully enclose a spatial area (draw a polygon.) Note that you can mark key 
locations for use when drawing your geologic map by adding a Placemark from the same 
“Add” menu; see Figure 3 for examples. Note that all of the new features that you add will 
be viewable from any zoom extent. Thus, you can zoom in to draw your features or mark 
points with Placemarks and then zoom out to see how your map interpretation looks. 
Features can be edited by clicking on the feature and then clicking on the pencil “Edit” 
button in the pop-up balloon. Features can be deleted by clicking on the 3 vertical dots in 
the popup balloon, and then selecting “Delete”.  
Remember that a completed geologic map will have the full mapping area marked by 
contacts and faults that bound colored regions which represent your interpretation of the 
areal extent for each unit. There should be no blank space within the yellow boundary 
polygon once your map is completed.  
Draft and final versions of your geologic map can be 
saved as KML files on your computer by clicking on the 
“File” dropdown menu and then selecting “Export as 
KML file” (see Figure 4).  We suggest that you 
iteratively save multiple versions of your draft geologic 
map to back up your work. The final version of the  
KML file is what you will turn in as Deliverable #1. 

 
 
 
 
 

 
 
 
 

Figure 4. Example of how to save your geologic map  
as a KML file on your computer by clicking on the  
“File” dropdown menu and selecting “Export as KML  
file”.

 



If you are not satisfied with the native background Google Earth imagery, you can 
download a KMZ file that has alternative basemaps (a USGS 1m shaded relief image, 
and a section of a 1999 USGS topo map) that you can use. These alternate basemaps 
can be downloaded from here: 
https://educ.jmu.edu/~whitmesj/Fieldwork/McCauley/McCauleyBasemaps.kmz.  
Load this file in Google Earth from the “File” dropdown menu the same way as you loaded 
the McCauleyMappingProject file (see Figure 2). Then select the background map you 
want to use by clicking on the eye symbol for that map. That will fix the chosen basemap 
to the Google Earth ground surface, after which you can go back to the 
McCauleyMappingProject file to work on your geologic map.  
Once you have completed your geologic map, you will need to draw a vertical cross 
section interpretation of the subsurface geology. At the left side of your Google Earth 
window, there is a label entitled “cross section”, and if you click on the “eye” symbol, a 
purple cross section line will appear trending from northeast to southwest across the 
middle of the field area. You can use the blank cross section box included with this packet 
to draft your cross section, by loading the box into a drawing program like Illustrator, 
PowerPoint, or Google Slides. You can rotate the Google Earth view of the cross section 
line in the field area to horizontal on your screen and then zoom to match the length of 
the cross-section line to the width of the cross section box (see Figure 5.) That will help 
you to accurately transfer your contacts and unit areas from the Google Earth geologic 
map to the surface topographic trace (the squiggly line in the box in Figure 5) in your 
cross section box. If you are unclear on how to draw an accurate cross section that best 
represents the geology of your field area, please talk to your instructor. 
 

 
Figure 5. Example of aligning the blank cross section box PDF image with the purple cross section line in 
Google Earth. 

 

https://educ.jmu.edu/~whitmesj/Fieldwork/McCauley/McCauleyBasemaps.kmz


Exercise Deliverables: 
1) The KML file of your completed geologic map of the McCauley field area. 
2) Descriptions of the lithologic units in the field area. These descriptions will use 

data from the field area and expand on the basic descriptions in Figure 6.  
3) A cross section from A (northwest) to A’ (southeast) across the field area; you 

can use the blank cross section box included in this packet and load it into a 
drawing program (like PowerPoint, Illustrator, or Google Slides) to draw your 
geologic interpretation. 

4) A neat and legible memoir/summary of the geology of your mapping area. Good 
memoirs start with the location and characteristics of a field area, present the 
field data and observations, and then discuss/interpret that data in a regional 
tectonic context. 

 

 
Figure 6: Lithologic units and symbology in the McCauley field area. 
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Supplemental Data: 
The next two pages consist of supplemental data that summarize measured sections 
from the McCauley field area, as reported in Tilton et al. (1927), Woodward (1941), and 
Woodward (1943.) These measured sections can be consulted for reference when 
considering the relative thicknesses of lithologic units in the field area. 



Woodward (1941, 1943) measured sections of Baker Quarry area 

Marcellus shale        475 ft. (estimated) 

Needmore shale        75 ft. (estimated) 

Oriskany (Ridgeley) sandstone      250 ft. (estimated) 

Helderberg interval        137 ft. 
 Mostly concealed; 27ft. of cherty Port Ewen at base; interval probably contains  

Coeymans, New Scotland, Port Ewan, and Port Jervis Formations 
Keyser limestone        69+ ft. 
 Upper Keyser limestone (incomplete?)  20+ ft. 

1. Thin-bedded nodular shaly limestone, top concealed  (10+ ft.) 
2. Massive impure semicrystalline knobby limestone  (10 ft.) 

Big Mountain shale     19 ft. 
3. Shale (interval may be telescoped)  (6 ft.) 
4. Hard semicrystalline blue limestone  (3 ft.) 
5. Concealed; shaley  (10 ft.) 

Lower Keyser limestone    30 ft. 
6. Cross-laminated irregular limestone  (11 ft.) 
7. Dense medium-bedded blue limestone  (8 ft.) 
8. Finely rubbly impure limestone  (6 ft.) 
9. Very thin-bedded irregular nodular limestone  (5 ft.) 

Tonoloway limestone        443 ft. 
 Upper Tonoloway     228 ft. 

1. Thin-bedded shaly limestone and calcareous shale, ribbony; faulted?  (40 ft.) 
2. Blue-gray thin-bedded thin-laminated limestone  (65 ft.) 
3. Covered; dip changes?  (32 ft.) 
4. Poorly bedded thin-laminated limestone  (91 ft.) 

Middle Tonoloway     89 ft. 
5. Quite tough massive thin-bedded blue limestone  (26 ft.) 
6. Shaly  (4 ft.) 
7. Irregularly bedded dark limestone; forms crag  (21 ft.) 
8. Same, more deeply weathered  (35 ft.) 
9. Brown-weathering cherty laminated limestone; Stromatopera?  (3 ft.) 

Lower Tonoloway     126 ft. 
10. Covered  (8 ft.) 
11. Quite massive thin-laminated blue limestone  (36 ft.) 
12. Massive dark limestone; Stromatopera  (6 ft.) 
13. Fairly massive thin-bedded laminated limestone  (33 ft.) 
14. Rubbly limestone, like Keyser  (3 ft.) 
15. Medium-bedded dark-blue thin-laminated limestone  (18 ft.) 
16. Medium- to thin-bedded argillaceous laminated limestone  (15 ft.) 
17. Rather massive laminated limestone  (4 ft.) 
18. Brown dense fairly coarse sandstone  (3 ft.) 



Prouty (1927), Woodward (1941) measured sections at McCauley 

Wills Creek limestone        458 ft. 
1. Concealed, probably shale  (83 ft.) 
2. Buff to gray-weathering calcareous shale and argillaceous limestone  (220 ft.) 
3. Thin interbedded shales and sandstone  (38 ft.) 
4. Coarse gray and buff sandstone  (9 ft.) 
5. Sandstone and shale  (25 ft.) 
6. Thin-bedded limestone and shale  (58 ft.) 
7. Gray thin-bedded sun-cracked sandy shale  (25 ft.) 

Bloomsburg red-bed facies       33 ft. 
8. Thick-bedded brownish-red to buff sandstone  (33 ft.) 

McKenzie formation        244 ft. 
9. Buff-weathering sandy and argillaceous shale; thin-bedded argillaceous and calcareous 

sandstones in 1- to 3-inch bands  (210 ft.) 
10. Thin-bedded hard buff-weathering sandstone and arenaceous buff shale; mostly 

sandstone  (4 ft.) 
11. Dark argillaceous and arenaceous shale; weathers buff to gray  (15 ft.)  
12. Concealed; probably shale  (15 ft.) 

Rochester shale        20 ft. 
13. Concealed; dark shale  (20 ft.) 

Keefer sandstone        41 ft. 
14. Massive gray to white quartzitic sandstone  (30 ft.) 
15. Concealed; probably shale  (4 ft.) 
16. Thin-bedded quartzitic sandstone  (7 ft.) 

Rose Hill formation        410 ft. 
17. Olive to gray thin-bedded shale and thin green-gray sandstones, somewhat calcareous 

and ferruginous at the top; Tentaculites minutus  (60 ft.) 
18. Deep-red ferruginous sandstone (ironstone)  (12 ft.) 
19. Olive-gray arenaceous shales and argillaceous sandstone  (190 ft.) 
20. Same; sandy beds more prominent  (15 ft.) 
21. Same; shales predominant  (12 ft.) 
22. Mostly hard olive to gray sandstones  (10 ft.) 
23. Olive to gray shales with gray interbedded sandstones  (111 ft.) 

Tuscarora (White Medina) sandstone     256 ft. 

Juniata (Red Medina); top 150 ft. exposed     150+ ft. 
 
 


